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Chapter 1. Getting Started

Introduction to the Pulsonix Vault

The Pulsonix Vault is a revision/version control system which allows you to manage Pulsonix
data in a company defined methodology.

The Vault can be installed locally or on a company server and provides controlled user access
to a database of Pulsonix data that can be checked in/out, deleted and modified with full audit
history.

Introduction to the Tutorial

This tutorial is intended to familiarise you with the Pulsonix Vault features and its
methodology by working through a step by step tutorial. Using a supplied Vault demo, the

tutorial will show you how to setup, install and use the Pulsonix various elements within the
Pulsonix Vault.

Additional Help

Help is available in a number of formats; Online help available by pressing <F1> at any time
when using Pulsonix; by emailing us at support@pulsonix.com, or by calling us or your local
distributor. You will also find the Vault Users Guide installed as a PDF file, this is instantly
available from the Pulsonix Help menu and <Online Manuals>.
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Chapter 2. Installing the Pulsonix Vault

Installing the Pulsonix Vault

To install the Pulsonix Vault, you will need to download (from the Pulsonix web site) and run
the Vault Server Setup application from the Windows Start menu and Pulsonix. You will also
find the icon on the right appear in your recently added applications.

= Recently added
2 Vault Admin

L] -
Ha Vault Server Setup

#
® 3D Viewer

A

u Access

Adobe Acrobat

You should now see the Vault Server Setup dialog.

Click the Install Demo Vault button to install the pre-populated Vault which will be used in
this tutorial.

Vault Server Setup X

Install & local Vault server pre-populated with sample data
I:> Install Demo Vault for evaluation of Vault features.
Install Vault Server Install & Vault server and empty database ready for use with your
own production data.

Pulsonix

Cancel

Once you have pressed the Install Demo Vault button, you will then be presented with the
Vault Demo Setup dialog as below:
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# " Vault Dermo Setup >

This Setup will install the database server, create a new Pulsonix Vault database, and populate
it with example design and library data to make it easy for you to see how the Vault works.

Install and launch Postgres database server
Create Pulsonix Vault database

Create data file folders

Share data file folders

Restore sample Vault data

Installation complete

Pulsonix

Click the Install Now button to complete the Vault Demo setup.

Note: If you already have a Postgres database running, press the Options button to set your
existing database credentials.

Signing In to the Vault

4

The final stage of installing the Pulsonix Vault is to activate it from within Pulsonix.

In Pulsonix, go to the Setup menu, click Vault, you will now see the Vault Setup - Sign In
dialog. From here, enter the User Name: ‘admin’ and Password: ‘password’ from the
Sign In tab, click Test to verify the connection, click OK to close the dialog once the
connection is verified and click OK again to close the Vault Setup - Sign In dialog.

Vault Setup — Sign In X
SignIn | Users Groups Revision Maming Attributes Options Colours Status  Version oK
(®) Primary Sign-in (_) Altemate Sign-in Cancel
User Name: admin
Apply
Password: password Show
Help
ODBC Driver: PostgreSQL ANSI{x64) Change...
Server Name: localhost
Server Port: 5432
Test
® Pulsonix >
Data Folder:
Login Status:
Vault 1D: | Vault successfully connected Signed In
Sign Out

You are now ready to start using the Vault functionality.
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Chapter 3. Vault Manager Overview

Vault Manager Overview

To open the Vault Manager, click the File menu and select Vault Manager. Within this
dialog you can search and investigate all the items that are saved within your Pulsonix Vault.

The picture below shows you the major facets that are within the Vault Manager.

User-definable Data transfer Vault Audit Vault folder Saved search quick- User-defined
folders tools history contents access bar reports
Vault Manager - Browser U X
Browser  Libraiies to Vault * Designs to Vaut  Audit Trail #—————————————————
Vaut Folders: Vaul hems: 3 [ ~]  search..
[l Parts
w =2 Vaul item ID Type Folder Name Revision | Status Checked Out by Any User Move
» i 156 Schematic Block : \Design Contenf\LED Display Project | CharacterLeds : 1.0 ecked O y Me
23 Design Contert Checked Out by 1 Deete
£ LED Display 2roject o Schematic Design | \Design Contentil ED Display Project  LED Display-3 : 1.0
= PCB Dsiynl \Dessign CunlenlLED Display Prujed | LED Display-3 : 1.0 eck Out.
<=3 Library Content i GrackiO)
43 Footprints Copy Out
-4 Parts i
Unched!
23 Vaut Demo
] PCB Doc Synbols —3  Repoits..
2] Schematic Doc Symbols v View
42 Schematic Symbols
5 rofles tem Detalls Revision: -
a —echnok il Audtt Trall <Latest Revision>
echnology Files Where Used
Refers To 1.0 (21072017 17.11.22.735)
Item ID Type | Action Date |T\me!tamp | Revigon | Action Type Notes User Name
133 an Part  21-07-2017 1857:01.247 | 21-07-2017 16:57.01.247 - 1.0 Added (with automatic referencing) : Adding Existing Libraries to the Vault - admin
Preview Of: [Far ‘KP-2012PEC"
«Component Helght>=1.1mm
LEC <Part Famiy>=KF-2012
Category=Led
AA I—EDZX 1 ‘25 Descrption=LED SMD CHIP BLUE
Mir=Kingbright
’ |—)
4D0.0 thou 5.000 mm
Close Help

Presentation
detail

Symbol Previews

Revision
selec!

number
tion

Part Attributes
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Navigating the Vault Manager

Upon opening the Vault Manager, you will be presented with a blank dialog, as shown below,
to navigate the Vault manager you can expand the folders by selecting the *+’ symbol.

B Vault Manager — Browser O X

Erowser Libraries to Vault Designs to Vault Format Files to Vault  Generic Files to Vault  Audit Trail  Import Vault Libraries  Export Vault Libraries

Wault Folders: Refresh Vault tems: - Search...
ltemID ~ | | Type ~ | Folder ~ | Name ~ | Revision ~ | Status - Maove...
=

a Design Content Beae
-4 Library Content Check Out...
423 Profiles

4 Technology Files

Copy Out...
Uncheck...
Reports...

View

Open the Design Content folder to show the content of the LED Display project. Within this
folder you will see a Schematic Block, Schematic Design and a PCB Design.

Selecting the Schematic Design, you will now see specific details relating to the Schematic
Design in the grid below.

Wault ttems: 3 = Search...
Item ID '| |Type - | Folder * | Name ~ | Revision = Move...
= - - - -
156 Schematic Block | \Design Content\LED Display Project | CharacterLeds | 1.0 Delete.
157 Schematic Design | \Design Content\LED Display Project | LED Display-3 | 1.0
158 @ | PCB Desion \Design ContentiLED Display Project | LED Display-3 | 1.0 Check Out...
Copy Out..
Uncheck...
Reports...
4 I View
:> ltem Details:  Audit Trai - | Revision: «<Latest Revision:> | <:| -
| | | : | . | . | .
TETmiwr v | | TYPE hd | ATIOTT UEeE hd | TTITTESEnTr i | REVISTOM™ |HI.IIUII TyPE
|_> 157 Schematic Design | 16-01-2025 12:44:22.792 | 17-04-2024 14:54:18.381.2 Added (with auti

» Changing the Item Details

Using the Item Details dropdown arrow, you can choose which information of the item you
wish to inspect. You can choose from Audit Trial (an audit history of the selected item),
Where Used (informs you where the Item is used, e.g. which Designs a selected Parts is
used in) and Refers To (informs you which items are used in the selected item e.g. Which
Parts are used in the selected design).

» Changing the displayed Revision

Using the Revision dropdown arrow, you can select which revision of the selected item will be
displayed in the grid. You can choose from the <Latest revision> (Default setting), <All
Revisions>, alternatively you can select a specific revision of an item.
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Chapter 4. Using the Pulsonix Vault

Creating a new design using Vault items

» To start a new Schematic design

On the File menu, click New and Schematic Design from the Design tab.

MNew

Designs | Technologies + Profiles | Wizards

| B8 PCE Design
— [ |
_E Scm Hierarchy Block
E'd Pce Footprint
B Pce Doc symbol
Schematic Symbol
Schematic Doc Symbol
=g Fart

Panel Design

Technology: |Defau|t (White) ~ |
: Profile File: |A—Landscape v|
[(]5et Units: Imperial:  |thou Metric:  |mm
1 S
Cancel

On the Technology: drop down list, click on the small 'down' arrow to reveal the list, select
Default (White - Imperial), by default this will be shown in the list with a blue background
to indicate it has come from your Vault.

On the Profile File: drop down list, click on the small 'down' arrow, select the A4-Landscape
profile file to add an A4 drawing blank, by default this will be shown in the list with a blue
background to indicate it has come from your Vault. More detail about Technology files and
Profile files is available in the online Help. For now, we will progress on to adding Components
to the design.

Click the OK button to start a new Schematic design.
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£ Pulkoni - [Schemtic Design: Desgn'sge1]

- Your Pulsonix window will look like

Ele Edt Vew Jnsert Setwp Utitis Smuaton Toos Qutput Window Heb - Ex

DEE & CUSIRENXOFEA-RQA, PAR I EEA BTN mBES duac] this to the left. To view the whole
k. " page, you may need to click <A>
3 f j on the keyboard.

J L \“2’- I3 \L 2 - I

o 1 \ I If you wish to start with a black
4 A A background, either change it in
Colours, shortcut <C> and the
A ] B Others page or start the new

A . , design with the Default (Black -
s Imperial) Technology file.

E2 B ke

gé < c

o — oo —

2 I

Do

1 2 S 3 I 4

Vauk: adme/admn|[6rd: <Workng> 25.000) Abs|11449.968- 10563.875-  thoul

s

Inserting Components from the Vault

» To Insert a Component

Select the Insert Component button on the SCM toolbar (docked left side) shown circled
below, or use the Insert Component option from the Insert menu. You can also use the
shortcut key Shift-C

il pylsonix - [Schematic Design: Tutorial:Pagel]
Fle Edit View Insert Setup Utiities Simulation
DEE & » ~  mlesKRNRNNE

m—y T

Ei:i
-

You are presented with the Insert Component dialog:
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B Insert Component X
Lok I |NaultDn|y] < | | (From ¥ ault) Add
IC arts? Eariee]
gee[ | Mopms[ | [ el
Matched: 10 of 10 [ Inchude Connectars
Pat:  [1N414g +  Fins Find...
Desc:  |Diode 1H4148 | Family [TNAN4T
Eootprint:| D0-35 - |
Mame: |D‘I |

Symbal |DIDDE-1

-]

Add ta Comp Bin ]

Wault Revision: | <Latest Revision>

1 =

[ Preview

Schematic & PCE [ Atrbutes [ Vault

On the initial start-up, the Look In: will default to [All Libraries], change the this to be [Vault
Only], this will then allow you to only place Parts that have come from your Vault.

For the purpose of this tutorial, we will now make a portion of the LED Display example circuit
which can be found in your Vault. As shown below:

14

13

R1

o
=
[=]

15

~

~

R K: K

x: K

@ o © o © o ™
E S 4 = B4 = 3
. Y = Z. iy E e 2
o = o = o 7 = o =0 7 = = o 7 =
CD4017BE
3
o
2
1
"
DCLOCK 2
|_
|
LOCK INHIBIT o 3
—
{ 10
RESET = 4
L]
[ 1
O 5
[m]
o <
[S
S
o &
[} +5Y
3
8
11
s 3|c
D& -
12 1 Nz z at
CARRY OUT
|/’L g 2MZZ2Z
U1 14143
t|E

The first Part to add is the CMOS Counter/Divider. One of the quickest ways to select the Part
you want is to simply type the first letter(s) of its name.

In the Part box, Type C, you will now see the CMOS Counter (CD4017BE) is filtered in the list,
now click the Add button to insert it into the design.
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B Insert Component X

Look In: |[‘v’au|tDnIy] | [Framaul

Which Parts:

Cancel
0 I 7 N

Matched: 10 of 10 [ Inchude Connectars

Pat  |EEEEE | - Pins: Find...

Desc:  |CMOS Counter/Divider | Family: [CD/CD40

Eootprint:| DIF1E ~ |

Mame: |U1 |

Symbol: [CD4D17BE [~] Add to Comp Bin  []

Waulk Fevision: |<Latest Revision: ~

Prexiew Schematic & PCE [ Atrbutes [ Vault

00000000

LEf

00000000

FFELTFEFLEET

1000.0 thow

» Adding Diodes

We will now add the Diodes to our design. Click on the Insert Component button again.
Type 1N148 into the Part field. Click the Add button to add the Part to your design. We want

to add 8 instances of this Part.
2§ j& ZX & keyboard to rotate a

R component during

o> placement.

w143

ZXM Use the ‘R’ key on your

Ns14s
ey

1

After you have inserted
the symbol, clicking
escape on your keyboard
will take you back to the
AN Insert Component Dialog.

DECODED DECIMAL OUT

oe

INe143
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Hint: Using the context menu during insert, you can select Insert Multiple Items, this will
allow you to insert 7 instances in one process.

» Add First Resistor
We will now add the first resistor to our design. Click on the Insert Component button
again.

From the drop-down arrow on the Part Field, select R 0.25W 5% MCF 10K and add it to your
design as shown in the diagram below.

; Use the 'R’ key on your keyboard to rotate a
component during placement.

13

CLOCK INHIBIT

15 10

RESET

After you have inserted the symbol, clicking
1 escape on your keyboard will take you back to
the Insert Component Dialog.

DECODED DECIMAL OUT

» Add Second Resistor

We now need to add the second resistor that has a different resistance value. Click on the
Insert Component button again.

From the drop-down arrow on the Part Field, select R 0.25W 5% MCF 330 and add it to your
design as shown in the diagram below.

-]

S

ui IN4143

CARRY QUT

» Add Transistor
The final Part we need to add the design is the Transistor. Click on the Insert Component
button again.

Type 2N222 into the Part field. Click the Add button to add the Part to your design. Your
design should now look something similar to the image below.

og
=3

2MNEzZ22
u1 M4 14E

CARRY OUT
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» Adding Signal References

We now need to add Signal References to our Design. To do this, click Signal Reference,
from the Insert Menu.

Ensure the Look In: is set to [Vault Only]. Select the +5V Symbol from the Symbol drop-
down list and using the Add button, insert the symbol above the Transistor in your design.
Upon adding the symbol into the design, a dialog will appear allowing you to define the Net on
the Signal, leave it as +5V and click the Use for all net type button.

Once you have inserted the +5V Signal Reference, press the escape key on your keyboard,
you will now see the Insert Signal Reference dialog, from here, select the GND symbol
from the Symbol list and add it to your design below R1.

~
@
E
2
a8

Your design should now look like the image below:

1N4L4B
=23

1 : 2
14148

os

1 : z
1N4148

D&

1 : 2

o7
1N4145

cDa017BE

Sclock

CLOCK INHIBIT

RESET

5

R1

DECODED DECIMAL OUT

RZ
L 2> R S o
— 7 E
GMND

2N2222

12 14148

CARRY OUT

p Adding connections to your design

To finish this example circuit, we need to add connections to this design.

To insert a connection, you can double click on a Symbol’s pin which will invoke the insert
connection option. Alternatively, you can use the Insert Connection mode, available from
the Insert menu.

Route the Schematic so it looks similar to the example below:
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7

1N+148
14148

1N4148
o7
1

=3
1

coa17BE

Lotk 2

OCK INHIBIT

REsET

AL

DECODED DECIMALOUT

H

—_— s
N

D&

R2
12 1 2 z

22222

u1 14143
e

Our example circuit is now finished, you can choose to click the Save option from the File
menu if you would like to keep a local copy of the file prior to checking it into the Vault. If you
do not choose to save the design, the Vault will automatically create a save version as you
check it into the Vault for the first time.

Checking a design into the Vault

With the example design we have just created open, click the File menu and select Check
into Vault.

You will now be presented with the Check Into Vault dialog.
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Adding

Check Into Vault x

Mame: | Tutorial Design | | Vault Item ID: I:I
Default Next Vault Revision Vault Revision: I:I

Vault Folder

| \Design Content{Tutorial Design | Browse...

Chedk In Note
Checking in for the first time

g4 il

| Close item after Check In

Cancel

In Name: type ‘Tutorial Design’. Next you need to define where the design will be saved to,
set the Vault Folder to be \Design Content\Tutorial Design. Finally, add a Check In Note for
the design.

When checked, the Close item after Check In option will close the design automatically for
you.

Press the OK button to check the design into your Vault.

items to the Vault

The next section of this tutorial will look at how to add new items to the Vault for the first
time.

We will look to add a Surface Mount resistor to the Vault as we do not currently have one in
the demo.

As there is already a resistor Schematic Symbol in the Vault, we will only need to add a
Footprint and Part to the Vault.

» Add SM0605 Footprint to Vault

From within Pulsonix, go to Setup, Libraries and click the PCB Footprints tab.
Clicking the drop-down arrow, open the SM library.
From within the Contents, select the footprint SM0603 and click the Check In... button.
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Folders  Schematic Symbols

Schematic Doc Symbals  PCB Footprirts  PCE Doc Sym

bols  Parts

3D View STEP Models

Cument Library: | SM

Cortents

Attributes..

PKG5-NBR
RO403
R0305
R2010
SDL
SHUNTS
SHUNTS
SHUNT?
SHUNTS
SHUNTS
SHUNT10

Move...
Import...
Load Tech...
Wizard...

To Doc Sym...

Export...

Preview

New Library...

Report... Index

{<Component Name>}

Check In... <::|

From within the Check Into Vault dialog, select the chosen Vault Folder and enter a Check
In Note for the Footprint. Press the OK button to check the Footprint into the Vault.

Check Into Vault

Vault Folder

| \Library Content\Footprints\Vault Demao

Erowse...

—
—

=

Chedk In Note

Checked in to Vault Demo for first time

Default Next Vault Revision O
Close item after Check In
Remove item from local library after Check In

Cancel

Check In as replacement
for existing vault item

s

Now the Footprint is in the Vault, we can look to create a Part, referencing the Schematic
Symbol and PCB footprint which is form the Vault.

p Create New Part to include Vault Items

From within the Library Manager, click the Parts Tab, select the Resistor Library from the
drop-down arrow and click the New button.
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Libraries - Parts

Folders Schematic Symbols ~ Schematic Doc Symbols  PCB Footprints  PCB Doc Symbols  Pats 3D View STEP Models

Cument Library: |Resistor | -
Attributes... MNew Library... Report... Index
Contents Preview Details
R 0.063W SMTF 10K ~

R 0.063W SMTF 12

Within the New Part Dialog, type the name for the new Part, this will be R 0.25W 10K. Now
you type a Description for the Part, its Name Stem and Pin Count.

Next, in the PCB View section, we need to assign a Footprint to the Part. Using the drop-
down arrow, search for the SM0603 footprint we added to the Vault.

Finally, in the Schematics View, search for the Symbol R which is in the Vault.

Mew Part b
Part Name: [R 0.25W 10K | | [ o ]
Part Type: (@ Mormal Patt () PCE Only (O Schematics Only Cancel

() Connector () Associated Part

Frovide Part Details Mow  [Quick Part Creation]

Description: |Thic:k Filrn Surface Mount Resiztor |

Part Family: | |
Marme Sterm: |H " |F'in Count: |2 | |
PCE View
Footprint:| SOG03 £ aulth + Pads:
Schematics Yiew
(® Single Symbal (O Multiple Gates
Symbal Fin Count: l:l
I:> Symbal | R ault] * Pinz
Total Schematics Ping: Ungated Pins: ICl
] Paower Pin [ Ground Pin
WCC GHD

» Adding Attributes to the Part

From within the Part Editor, we can now add Attributes to the Part, these will then be
searchable from within the Vault should we need to search for them.

Type 10K in the Value field and Resistor in the Category field.



Pulsonix Tutorial 19

f~1 Pulsonix - [Part: C:\Users\Documents\Pulsonix\MasterLibraries\Resistor.pal: R 0.25W 10K *] If you wish to add more

mm Fle Edit View Insert Setup Tools Window Help attributes, go to the
DeE © S RNEENS D Insert menu and click
W Attributes Attributes.
y Name Parts R 0.25W 10K

0= ['Value 10K |
3 | category Resistor |
#
=3

i

I

4 » v o Details » Parts and Attributes 4 Fins ¢ Gates 4 Assoc Parts

& LED Display-3 * ,.@a R 0.25W 10K *
For Help, press F1

p» Check Part into Vault

Now the Part is complete, we now need to check it into the Vault. From the File menu, click
Check Into Vault.

Select the chosen Vault Folder and enter a Check In Note for the Part.

Check Into Vault x

Mame:; | R 0.25W 10K | Vault Item ID: I:I
Default Next Vault Revision Vault Revision: I:I

Vault Folder
|:> | \Library Content\Parts\Vault Demo | Browse...
Chedk In Note
Checking in to the Vault Demo for the first time

Close item after Check In
[ remove item from local library after Check In

Cancel

Update Vault Design with Vault Part

p Update Tutorial Design with R 0.25W 10K Resistor

We will now check the Tutorial Design out of the Vault and replace the now deemed ‘obsolete’
10K Carbon Film resistor with the more modern Surface Mount version we just created.

From within the Vault Manager, open the Tutorial Design folder, select the Tutorial
Schematic Design and click the Check Out... button. Add a note in the Check Out Note
section and press OK.
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Browser Libraries to Vault Desions to Vault  Format Files to Vault ~ Generic Files to Vault  Audit Trail  Imoort Vault Libraries

Vauk Folders Refresh Vault tems: 1 v || Search
4 Vaut tem 1D | Type Folder Name Revision Mave...
207 Schematic
a Design Content Check Out % P
$..5] LED Display Project
Vault Ttem: Check Out
5 Tutorial Design
] Thorary ot Type: |S|:hemah( Design ‘ e
<3 Footprints :
-4 Footp D: [207 | e
=-&3 Patts
§ L0 Vauk Demo Neme: | Tutoril Design | Repots...
42 FCB Doo Symbols Folder: | \Pesign Content\Tutorial Design ‘ View
45 Schematic Doc Symbols
23 Schemalic Symbols fem Detais: [ReferTo | gy [<etestreson> -]
4= Profiles Item ID Type Revision | Timestamp ~
w43 Technology Files 121 Schematic 1.0 21-07-2017 16:55:41.917
128 an  Part et 330110 311072017 16:56:59 689
130 an  Part 0 511073017 16:57:00.370
Replacing Carbon Film resistor with Surface Mount resistor -
3 an | Part io 311673017 16:57:00.683
7 v
13 == Part Settngs 10K 0 21-07-2017 16:57:02.071
Open For Edit
Corce
200.0 the 400.0 thou
Close Help

Once checked out, you will notice the Tutorial Design has changed its background colour in
the Vault Manager. This indicates the item has been checked out by a user. Changing the
Item Details: to display the Audit Trail allows you to see the action that has occurred and
by whom.

7 Vault Manager - Browser o x

Browser Libraries to Vault Desians to Vault Format Files to Vault  Generic Files to Vault  Audit Trail  Imbort Vault Libraries

Vault Folders: Refresh Vault ftems: 1 i Search.

523 Vauk ttem 10 | [ 7ype [Foiaer Name Revision Move...
42 Design Cortent 207§ + Schematic Design | \Design ContentiTutorial Design : Tutorial Design | 1.0
. Delete
{49 LED Display Project
{2 Tutorial Design Check Out
& Library Contert Copy Out.
4] Footprints
= Uncheck.
-4 Parts
¢ e Vault Demo Reports.
43 PCB Doc Symbols e
145 Schematic Doc Symbols |
5423 Schematic Symbols tem Detals: [Audt Trai ~ Revision: [<Latest Revision> o )
-3 Profiles Item ID Type ‘Action Date Timestamp Revision | Action Type Notes User Name
++43] Technolagy Fies 207 W] : Schematic Design  28-07-2017 13:01:52.861 : 27-07-2017 10:01:14916 1.0 Checked out Replacing Carbon Fim resistor with Surface Mount resistor | admin
207 Schematic Design | 27-07-2017 100115 351 ; 27-07-2017 10:01:14.916 | 1.0 Woved "Design ContentiTutorial Design admin
567 Schematic Design | 27-07-2017 10:01:14.916 ; 27-07-2017 10:01:14.916 | 1.0 Added (with automatic referencing) | Checking in for the first time. admin

P Replace Resistor in the Tutorial Design

Select the component R1 in your design, right click and select Replace Part from the Context
Menu.

From within the Change Part dialog, click the change button and select the R 0.25W 10K
Resistor we added to the Vault earlier in this tutorial. Click the Replace button to update the
design with the new Part.
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| | s |
0
B Replace Part *
Feplace This:
Part: |F| 0.25w 5% MCF 10K ~ |
Desc: |Earb0n Filn R esistor | Pins:
Famiy:  [R 0.25w |
Footprint: |<An}l Foatprint: - |

Feplace With:
A

Part: |F| 0.25w 10K §| LChange...| | Database...
V

Desc: |Thic:k Film Surface Mount Resistor | Pins: |:|

Famiy:  [R 0.25w

| Alternate. ..

Footprint: |

> |

‘which Components:
Look for components ta replace in:
(O whole Design
(® Selection Only

Current Page

Current Black

=

Wiew Report

Fieplace Options:

[ Keep attribute styles & positions

Keep local attibute values

[] Replace nets assigned to ungated pins
[ Update predefined nets on symbal pins
[ Update name stem

Feplace gate symbols with defaults

[] Show Report after Feplace

Cancel

We can now check the design back into the Vault. From the File menu, click Check Into
Vault, add a Check In Note and press OK to finish.

Check Into Vault

Mame: | Tutorial Design |

Default Next Vault Revision
Vault Folder

\Design Content{Tutorial Design

s

Vault Revision:

Browse...

Chedk In Note

Replaced Carbon Film resistor with Surface Mount resistor,

Close item after Check In
Remove item from local folder after Chedk In

Cancel
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Investigating items within the Vault

Now that we have more than one revision of the Tutorial Design in the Vault, we can start to
see an audit history of what actions have happened and by whom.

If we change the Item Details: to Refers To, and the Revision: to <Latest Revision>, we
will see the design now contains the new resistor we have added to replace the ‘obsolete’
Carbon Film resistor.

ltem Details: |Re‘fers To |v| Revision: |<Latest Revisionz - | <:I

Item ID Type Folder Name Revizion | Timestamp

147 :f: Schematic Technology : \Technology Files Default (White - Imperial) ; 1.0 21-07-2017 16:57:45.921
192 == | Schematic Doc Symbol ; \Library ContentiSchematic Doc Symbols\Wault Demo : A4-Border-Landscape 1.0 26-07-2017 09:47:30.254
200 } Schematic Profile \Profiles Ad-| andscape 1.0 28-07-2017 09:55:32.113
2N an | Part ‘Library ContentiPartsiV/ault Dremo R 0.Z5W 10K 1.0 28-07-2017 12:52:24.095

Preview Of:  |Part 'R 0.25W 10K’

«Component Height >=

R S M 6 @ 3 E:th:;jengrE;siﬁor

Description=Thick Film Surface Mount Resistor
MRP No=
— — H R Value=10K
12K

300.0 thou 4.0 mm

We now need to if the ‘obsolete’ Carbon Film resistor is used in any other designs and will
then be able to update those designs with the new Surface Mount version accordingly.

» Locate Carbon Film Resistor

To locate the Carbon Film Resistor we can change the Design Revision: to be 1.0, as we
know this design revision uses the old resistor. Select the Resistor in the Item Details section,
right click and select Show ‘Where Used’ from the Context Menu.

hem Details: [Refers To [~] Revision: 1.0 (27-07-2017 10:01:14 516) ~]

Item 1D Type Folder Name Revision | Timestamp

132 an Part ‘\Library Content\Parts\Wault Demo CD4017BE 1.0 21-07-2017 16:57:00.852
136 an :Part ‘Library Content\Parts\vault Demo R 025V 5% MCF 10K 1.0 21-07-2017 16:57:02.071
138 an Part ‘Library Content\Parts\WVault Demio Q Show "Where Used' 21-07-2017 16:57:02.868
147 Ef: Schematic Technology | \Technology Files Show 'Befers To' 21-07-2017 16:57:45.921
192 |2 | Schematic Doc Symbol : \Library Content\Schematic Doc Symbols\Wault Dema T A2-Border-Landscape | 1.0 26-07-2017 09:47.30.294

Preview Of:  |Part 'R 0.25W 5% MCF 10K'

<Part Family>=R 0.25W
Category=Resistor/Carbon Film
Description=Carbon Film Resistor
R R 2,500 Re10K
300.0 thou 9,000 mm

The Vault Manager will now ‘jump’ to the Item Details table for the Resistor Part and list all
the designs it is used in.
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We can see that the Carbon Film resistor is also used in the LED Display Schematic and PCB
Designs. These would need to be checked out and updated before the next iteration is

produced.
ltem Details: |Where Used |v| Revision: |cLatest Revision v|
Item 1D Type Folder | Name Revision | Timestamp
157 Schematic Design | \Design ContentLED Display Project | | D Diznlaw-3 1.0 i 21072017 17:08:14.212
158 &  PCB Design \Design Content\LED Display Projec [, Show "Refers To' F-zmr 1711:22.736
207 Schematic Design ; \Design Content\Tutorial Design Tuterial Dezign 1.0 27-07-2017 10:01:14.918

Preview Of:  |Part 'R 0.25W 5% MCF 10K’

<Part Family>=R 0.25W
Category=Resistor/Carbon Film
Description=Carbon Film Resistor
R R 2,508 R=10K
300.0 thou 9,000 mm

Creating a Search in the Vauilt

We will now look to create a Search from within the Pulsonix Vault, these can be saved for
easy access in future.

From within the Vault Manager, Click the Search... button.

You will now be within the Search in Vault dialog, change the Find: to be Schematic
Design and press the Apply button.

Browser Libraries to Vault Desians to Vault Format Files to Vault  Generic Files to Vault Audit Trail  Import Vault Libraries

523 Vauk ftem 1D Type Folder Name Revision Move...
5423 Design Cortent 187 Schematic Design - \Design ContendLED Display Project : LED Display-2 : 1.0
9 LED Display Froject 207 Schematic Design | \Design ContentiTutorial Design - Tutorial Design 1.3

43 Tutorial Design
- Library Content
<=3 Footprints

E-4] Parts
£ Vault Demo Find: | Schematic Design Clear Load... Save Save As... ~ Reports
£ PCB Doc Symbols Viow
(-] Schematic Doc Symbols O |iemid Equal to
; |
<=5 Schematic Symbols O [emo Equal
43 Profiles
-] Technology Fies O |iemid Equalto
O <Any User> [show Checked-out State

Apply Close
I

Now click the Save As button, and type Vault Schematic Designs for the name of your
search and press Save.
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x4 Save As >
NN <« Pulsonix Vault v | & Search Checked Out Files el
Organize * MNew folder 1=z - o
e Mame Date modified Type
7 Quick access
I Desktop Mo items match your search.
* Downloads

|| Documents
&= | Pictures

& iCloud Drive

LU NN 4 >
I:> F“Eﬂame:” Vault Schematic Designs “
Save as type: | Vault Find Settings (*.vfs) ~

~ Hide Folders Cancel

Going back to the Vault Manager, you will now see the Search is available from the drop-down
arrow for ease of access and use in the future.

O X Note: You could create
quick searches to show All
items currently checked out

f— of the Vault, or All items
|:> Search... checked of the Vault by
Revision Move... user X.
1? Delete...

Seeing the Audit History within the Vault
When you wish to see recent activity within the Vault, you can use the Audit Trail tab to see
what actions have occurred, when they occurred and by whom.

» Create Audit Trail Query

Enable the Filter By: section, tick the Latest: box and enter 10 in the value section. Now
select the entries radial button.

Tick the Where: box and select Action Type, Equal to and Added in the drop-down boxes.

Now press the Apply button to see the results of your query.
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B Vault Manager — Audit Trail O X

Browser Libraries to Vault Designs to Vault Format Files to Vault  Generic Files to Vault | Audit Trail | Import Vault Libraries  Export Vault Libraries

Fitter By:
Latest: |10 (Cidays (hours ()entries
[#]Where:  Action Type - | Egualte » | |Added - Apply
[Jttem ID:

Report Settings | Print Report C5V Report

Close Help

From this search, we can see two items have been added to the Vault, the time and date they
were added, by whom, what the item was and the note that accompanied the check in.

B Vault Manager - Audit Trail | X

Browser Libraries to Vault Designs to Yault  Format Files to Vault  Generic Files to Vault | Audit Trail | Import Vault Libraries  Export Vault Libraries

28-07-20171252:24085 211 admin Added Part R 0.25W 10K [1.0] "Checking in to the Vault Demo for the first time. "
28072017 10:56:01.580 210 admin Added PCB Footprint SM0&03 [1.0] "Checked into Demo Vault for first time. "
Date & Time User ltem Check In Mote
ltem Action
Number

This completes our brief run-through of the Pulsonix Vault.

Additional Information

There are more aspects to Pulsonix Vault which are not covered in this document. Further
information can be obtained in the Online Help using the <F1> key at any time, or from the
Pulsonix Users Guide supplied as a PDF file under the Help menu and Online Manuals or on
our web site.

While evaluating Pulsonix or once you’ve purchased it, technical support is provided in the
form of telephone support from our office or from your local sales office, or by email.

Head office support +44 (0)1684 296 570

Head office email support support@pulsonix.com

Web site www.pulsonix.com




